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Dispensing Machine Limited Warranty 
 

 

AutoCrib incorporated warrants that its hardware products (see separate warranty agreement for 
software products) are free of defects in material and workmanship in accordance with the terms and 
conditions stated below.  AutoCrib will repair or replace any machine, sub system or component part 
that fails during the warranty period.   
 
Standard Warranty Period  
 
For a period of 12 months, following after the actual ship date from AutoCrib to the first purchaser of 
use. The warranty period covers all components, sub systems, and complete machines subject to the 
limitations and exclusions below.  
 
Software and Technical Support  
 
The standard AutoCrib warranty covers all software systems required for operation of your AutoCrib 
equipment including software and firmware imbedded, hosted through a client server network, or 
hosted on via AutoCrib.Net web based hosting system for a period of 12 months, following the actual 
ship date from AutoCrib.  Included in the warranty is access to our 24-hour technical support staff and 
entitles buyer to any and all software upgrades during that time.  Annual software support can be 
purchased at then current rate after the initial warranty period expires.  You are not required to 
purchase extended hardware maintenance to purchase extended software support.  
 
Extended Warranty Period  
 
For a period of X months as defined in the extended warranty contract, following the actual ship date 
from AutoCrib to the first purchaser of use.  The warranty period covers all components, sub systems, 
and complete machines subject to the limitations and exclusions below.  
 
Any parts or services replaced or serviced pursuant to this warranty are warranted only for the 
balance of the remaining warranty period.  AutoCrib will dispatch an AutoCrib technician, authorized 
AutoCrib dealer technician, or a certified third party technician to your facility to perform any 
necessary troubleshooting tasks.  It is your responsibility to provide an internet connection with proper 
permissions to allow AutoCrib technical support associates to access the controlling computer as well 
as the individual machines.  If you do not provide this, you will be charged an hourly rate of $84 per 
hour for onsite troubleshooting services.  Any defective parts must be returned to AutoCrib within 30 
days at your expense.  You must indicate the RMA number on the box(es) that will contains any and 
all defective parts to be returned.  If you do not provide the RMA number or fail to send the defective 
part back to AutoCrib you be charged for the defective part.  
 
Further, no authorized AutoCrib dealer/distributor is authorized to waive, modify, or change any 
terms, conditions, or limitations of this warranty.  This warranty is a part of the invoice which the 
warranted machine or hardware relates.  
 
Machines and Systems purchase through an authorized AutoCrib Distributor  
 
All AutoCrib systems purchased through an authorized AutoCrib Distributor may contact their 
distributor or AutoCrib directly, AutoCrib technical support will make every effort to correctly 
troubleshoot the machine/system and determine the defective part and the correct course of action to 
repair said machine or system.   



Dispensing Machine Limited Warranty 
 

 

 
 
AutoCrib provides depot level warranty coverage, which is defined as:  
 
Depot level warranty means a new part/subsystem/machine will be shipped overnight to you or your 
authorized distributor and billed to you or your distributor at the then current price.  Your distributor is 
required to ship the defective part/subsystem/machine back to AutoCrib within 30 days from the ship 
date of the replacement part.  You agree to contact AutoCrib customer service and get an “RMA” 
(return material authorization) number before you ship the defective part back.  Upon receiving the 
defective part, AutoCrib will issue an offsetting credit to your company or authorized distributor per 
your instruction.    
 
Limitations and Exclusions  
 
This warranty shall not cover or include any of the following and AutoCrib shall have no liability with 
respect to: 
 

1. Defects or damages which result from accident, misuse, abuse,  lack of recommended or 
reasonable maintenance, improper repairs or parts replacements, use of replacement parts not 
conforming to AutoCrib standards, unauthorized modifications or general neglect including 
electrical spikes, surges and sags caused by poor power management, thunderstorms or acts 
of god or lack of normal power conditioning for electronic manufacturing equipment.  

 
2. Damage caused by exposure to liquid spills, collision, fire, theft, freezing, vandalism, riot, war, 

explosion or objects striking the machine such as fork trucks or exposure to abnormally 
corrosive conditions or entry by insect or vermin or foreign objects or mispackaged or 
misplaced product inside the machine.  

 
3. Routine replacement main of consumable parts such as but not limited to light bulbs, plastic 

breakable lock boxes, batteries, RFID tags, printer paper rolls, printer cartridges etc.  
 

4. Routine maintenance services such as lubrications of drive trains or actuation solenoids.  (See 
appropriate AutoCrib manual for details) 

 
5. Subsystems and attachments to the hardware/machine not manufactured by AutoCrib that are 

subject to warranties of the manufacturers of such items. Ie. Uninterruptible power supplies, 
surge protectors etc.  

 
Modifications and Upgrades  
 
AutoCrib reserves the right to make certain changes in designs or changes and improvements in 
its products at any time without obligation to make such changes or improvements in its products 
previously manufactured.  
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Limitation of Liability  
 
AutoCrib makes no warranty with respect to automated dispensing equipment sold by it, 
express or implied except as expressly set forth herein.  AutoCrib’s liability whether in 
contract or tort, or any legal theory, arising out of warranties, representation, instructions 
or warnings, (or any lack or inadequacy thereof), deficiencies, failures or defects on any 
kind, or from any cause shall be limited solely to repairing or replacing defective parts 
(during normal business hours) pursuant and subject to the foregoing provisions.  
Regardless of whether the buyer’s limited remedy has failed of its essential purpose, 
AutoCrib shall not be liable in any event for any special, indirect, incidental or 
consequential damages, including but not limited to lost profits, nor shall any claim or 
recovery of any kind exceed the purchase price of the machine or system to which such 
claim or recovery is made.   
 
The foregoing warranty is in lieu of all other warranties, express or implied, and AutoCrib 
disclaims any warranties of merchantability and fitness for use or a particular purpose.  
This warranty is effective with AutoCrib installations beginning January 1, 2009.  
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Equipment Supplied 

 Complete RoboCrib 2000 

 Battery Backup 

 Table Lock & Screws 

 Drivers & Screws Set 

 Adjustment Foot Set 

 Logo Sign & Screws 

 Door Keys (4) 

 Spare Door 

 Network Hub 

 25 ft CAT5 cable 

 10 ft CAT5 cable 

 3 ft CAT5 cable 

 Operating Instructions (this manual) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Accessories  Replacement Parts 

AutoCrib P/N Description  AutoCrib P/N Description 

234-200 Battery Backup UPS  775-217-RP Baffle Assembly – Bottom 

760-103 CAT 5 Cable -  3 ft  770-413 Baffle Motor Assembly 

760-000 CAT 5 Cable - 10 ft  741-402 Baffle Slide Pot Assembly 

760-125 CAT5 Cable – 25 ft  770-407-RP Controller & Power Panel 

255-805 Hub – 5 Port  775-525-RP Door Assembly 

312-001 Key Replacement – 2 per set  775-525-S-RP Door Assembly - Frameless 

282-112 Keyboard Cover  770-404 Door Solenoid Latch Assembly 

770-150 Leveling Foot Pad Set  170-376 Door Ribbon Cable 

329-900-2 Logo and Model Panel  282-105 Keyboard Trackpad USB 

371-241 Main Platter Lock Bracket  610-252-RP Touch Screen Replacement Kit 

990-781 Pin-In-Hex Driver  475-604-RP Sensor Board - LSP 

690-770 Screw Set for Robo 2K  475-617-RP Sensor Board – Main Platter 

282-120 Touch Screen Cover  475-605-RP Sensor Board - SSP 

RoboCrib Specifications 

AutoCrib  
Specifications 

 Domestic 
Ambient 

 Export   
Ambient 

Height      83” 83” 

Width 62” 62” 

Depth 62” 62” 

Voltage  (AC) 120V 230V 

Running Amperes 5 Amps Max 2.5 Amps 
Max 

Shipping Weight 2404 lb 2404 lb 
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Cautions 

The following cautionary information should be reviewed before the machine is installed.  Following these requirements 
and warnings are required. 

 
 

CAUTION: This machine is designed for indoor usage only.  Any other usage will void 
the Manufacturer’s Warranty. 

  

 Voltage and Polarity Check  
It is important that this machine be hooked up to the proper voltage and polarity for 
your country.  Use a voltmeter to verify voltage and polarity before connecting the 
machine to a wall outlet.  For machines located in North America, use the diagram 
below to verify correct voltages. 

  

 

CAUTION: Any procedure marked with the symbol at left requires that the Machine 
have the power applied and a shock hazard exists. 

  

 CAUTION: It is important that this machine be hooked up to the proper voltage and 
polarity for your country.  Use a Voltmeter to verify voltage and polarity.  Should the 
reading be any different from a normal reading or if you are unsure of what the 
reading should be contact an electrician. 

  

 

CAUTION: Different countries may have unique plug arrangements.  Ensure that the 
machine is properly grounded before operating. 

 

   
CAUTION: The machine is a heavy item.  Ensure that sufficient personnel are 
available for lifting and transporting the machine.  Use proper lifting procedures and 
equipment. 
 

 

   
CAUTION: The system components in this machine utilize static sensitive 
components.  Precautions for handling sensitive devices should be observed when 
handling these items. 
 

 

Voltage and Polarity Check (for Machines located in North America Only) 

It is important that this machine is hooked up to proper voltage and polarity. Using a voltmeter, perform the following 
checks from the illustration below. 
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A 

A 

RoboCrib Setup 

 

The AutoCrib unit is assembled and packed so that a minimum amount 
of time is necessary for preparation to install it on location.  The 
following steps are recommended to insure correct unpacking. 
 
1.  Shipping Damage:  Thoroughly inspect the exterior of the crate 

and/or wrapping for damage, which may have occurred during 
shipment.  

 Verify “TipNTell” is intact.   

 Note any damage or irregularities on shipping document. 

 Report any damage to delivering carrier and follow their 
instructions. 

 
2. Uncrate the machine. 

 Using a cordless drill with a #2 Phillips head bit, remove 
screws on crate. 

 Retain the screws and crate in case there is damage to the 
machine. 

 
3.  Use a forklift to place the RoboCrib and pallet near the final 

location. 
 
4.  Undo the hold-down straps and lift the RoboCrib from the pallet with 

the forklift frame.   

 Do not lift on the Main platter.  It is important that the feet of 
the forklift are completely inserted into the fork points.   

 Unwrap the unit and roll the RoboCrib to its final location. 

 Store the pallet and straps for possible future use. 
 

 

Installation 
 
1. Locate the keys attached to the keyboard plate by zip tie. 

 
2. Unlock the Controller Access Door and the Computer Access 

Door. 
 

3.  Remove the Logo Sign, pin-in-hex driver and leveling feet stored in 
a box behind the computer.  (The box will also contain a spare 
door, network hub, CAT5 cables, and spare fasteners.)  Install the 
leveling feet. 

 Use a forklift to lift the RoboCrib off the ground. 

 Install feet into the threaded plates at each corner. 
 
4.  Place the RoboCrib in its final location and adjust the nuts, using a 

¾” open-end wrench, to level the machine.  Use a spirit level to 
make sure the RoboCrib is level on each side.  Lock the nuts in 
place. 

 
5. Install the Logo Sign on the Controller Access Door using the 

screws provided. 
 

6. Remove the Right Front wall panel using a 7/16 wrench to remove 
the screws.  Lift up on the panel to disengage the tabs located on 
edges and pull out on the panel to remove it.    

 

Fork Points 

Controller Access Door 
and Service Panel 

Remove panel screws 
using a 7/16 socket 
driver.  Remove this 

side panel. 

Door keys are zip tied 
under keyboard 

Computer Access Door.  
Accessories Stored 

here. 
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7. Remove the safety shipping locks.  They are tied together with 

a string to make them easy to identify. 

 Remove the Top Arm Lock by removing the two 3/8 hex 
bolts that hold the lock bracket to the crossbar.  The 
bracket slides off the end of the stack support arm. 

 Retain the bolts, brackets, and nuts for possible future use. 
 

 

Removing Main Platter Locking Bolt and Clamp 
 

- The Main platter locking bolt and clamp is located on the 
sensor bracket below bin door #1. 

- Loosen the lock nuts and unscrew the bolt using two 9/16 
wrenches. 

 

 

Removing Top Arm Lock 
 

- Remove the Top Arm Lock by removing the two 3/8 hex bolts 
that hold the lock bracket to the crossbar.  The bracket slides 
off the end of the stack support arm. 

- Retain the bolts, brackets, and nuts for possible future use. 
 
 

Top Arm Lock 

Main Platter Bolt & Clamp 

Remove bolt with 9/16 
open end wrenches 

Top Lock Bracket 

Top Lock Bolts 3/8” Hex 
Driver or Slot Screwdriver 
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1 Parallel Connector 

2 Serial Connector (for custom 
readers) 

3 Link Integrity Light 

4 Network Connector (NIC) 

5 Network Activity Light 

6 Line-out Connector 

7 Line-in Connector 

8 USB 2.0 Connectors (6) 

9 VGA Video Connector 

10 eSATA Connector 

11 DisplayPort Connector 
 

Attach Power and Network Services 
 
1. Uncoil the power cord and route through the bottom or top of the 

frame. 
EXPORT SYSTEMS:  Add correct power cord connector and UPS 
system 
 

2. Prepare the UPS battery backup provided with the system (except 
export systems) by installing the battery as directed by the 
instructions accompanying the UPS.     

 Attach the UPS to a grounded 120VAC outlet, power it on, and 
let charge for 8 hours. 

 Ensure the Status Light is green.  If the Status Light indicates 
a different color, have an electrician re-certify the outlet before 
attaching the RoboCrib.   

 Avoid using circuits that have loads or surges from adjacent 
equipment. 

 
 
 
 
 

3. Position the UPS so that the RoboCrib power cord can be 
attached.  Attach the cord to a battery-protected outlet on the UPS. 

 
4. Route the CAT5 cable into the machine along the same path as 

the power cord.   

 Attach the CAT5 cable from the NIC card (#4 on diagram) 
located at the bottom of the computer to the LAN drop 
provided by the customer (or to the Ethernet hub provided by 
AutoCrib). 

 Once the connection has been made and the pc is started, the 
two lights on the NIC should blink. 

 
5. Turn the Main power switch on the Control Panel to ON.  Verify the 

light in the switch turns on. 
 

6. Turn the Controller power switch ON.  Verify the green “OK” LED is 
blinking slowly, the pc turns on, and the monitor is working.  The 
system will automatically launch the RoboCrib software and will 
prompt for calibration. 

 
7. Close & lock the Computer Access Door.   
 

DO NOT ALLOW ANY OTHER DEVICES TO BE ATTACHED TO 
THE BATTERY PROTECTED SIDE OF THE UPS.  If more devices 
must be attached, do so in the surge-protected side only. 
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Check Platter Actuation 
 
1. Test each motor clockwise (CW) and counter-clockwise (CCW) for 

a few seconds.   

 Position the Direction switch in either the CW or CCW position.  
Then, activate the Motor Switch. 

 Observe proper rotation.  Then, reverse the Direction switch 
and test again. 

 As each Motor switch is actuated, the appropriate platter 
should turn, and the sensor lights should blink.  While testing 
each motor, please note how the platters should react to the 
movement.  See the appendix for a drawing of the motors, 
platters, and bins. 

 
2. Test the door baffle by positioning the Direction switch in either the 

CW or CCW position and actuating the Baffle switch.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Main:  Main Platter – the entire internal array 
will rotate 
 
LSP:  Large Sub Platter – 3 individual and 3 
groups of 3 trays assemblies will rotate 
 
SS3, 2, 1:  Small Sub Platters – Individual tray 
assemblies in groups of 3 will rotate 

SWITCH DEFINITIONS 
 

MP = MAIN PLATTER  
LSP = LARGE SUB PLATTER  
SSP3 = SMALL SUBPLATTER #3  
SSP2 = SMALL SUB PLATTER #2  
SSP1 = SMALL SUB PLATTER #1 
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Management Station Configuration 

STEP 1 – Setup Computer 

- Plug in mouse, keyboard, monitor, and printer. 

- Plug in power cord to computer, monitor, and printer. 

- Plug in power cord to network hub, if necessary. 

- Connect CAT5 cable into NIC (Network Interface Card) on pc 
and into either a network hub or LAN drop. 

- Start the computer and have IT configure proper LAN settings. 
- Turn off the AutoCrib software. 

 

 

 

 

 

STEP 2 – Restore the Database 
- Unzip the file database received from AutoCrib‟s customer 

service department into C:\Program Files\Microsoft SQL 
Server\MSSQL.1\MSSQL\Backup. 
 

- Start the Microsoft SQL Server Management Studio software.  
Connect to the server. 

 
o Server Name:  Computer Name\AUTOCRIB53 
o Authentication:  SQL Server Authentication 
o Login:  sa 
o Password:  AutoCrib2005 

 
 

 
 

 
- Select the (+) sign next to the server.  Then, select the plus (+) 

sign next to the databases folder. 
 

- Right click the autocrib53 database.   
 

- Select “Tasks” > “Restore” > “Database…” 
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- Within the „Source for Restore‟ menu, enable “From Device”.  

Then, select the Browse button. 
 

- Select the “Add” button within the „Specify Database‟ screen.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Highlight the .BAK file saved in C:\Program Files\Microsoft 
SQL Server\MSSQL.1\MSSQL\Backup.  Then, select “OK”. 
 

- Select “OK” in the „Specify Backup‟ screen. 
 

 
 

 

 

 

 

 

- Within the „Select the backup sets to restore‟ menu, check the 
“Restore” box.   
 

- In the upper left hand corner of the screen under the „Select a 
page‟ menu, select “Options”.   
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- Within the „Restore Options‟ menu, check “Overwrite the 
existing database”. 
 

- Within the „Restore the database files as:‟ menu, select the 
first browse button. 
 
o Locate the autocrib53_Data.mdf or autocrib53.mdf file 

located in: 
 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data 
 
Then, select “OK”. 
 

o Select the second browse button, and locate the 
autocrib53_log.ldf file located in: 
 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data 
 
The, select “OK”. 
 

- Under the „Recovery state‟ menu, verify “Leave the database 
ready to use by rolling back uncommitted transactions.  
Additional transaction logs cannot be restored.  (RESTORE 
WITH RECOVERY)” is selected. 
 

- Select “OK”. 
 

- Once the message “The restore of database „autocrib53‟ 
completed successfully” appears, select “OK”. 

 
CONGRATULATIONS!!!  The database has now been restored and 
you are ready to begin using the AutoCrib software. 
 

- Start the AutoCrib software. 
NOTE:  If the AutoCrib software prompts for the server, 
database name, username, and password, insert the following. 
 
Server:  (LOCAL)\AUTOCRIB53 

Database Name:  autocrib53 

Username:  sa 

Password:  AutoCrib2005 
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STEP 3 – Complete RoboCrib Setup 
- Exit from the RoboCrib software on the RoboCrib. 

 
o Click on the AutoCrib icon in the upper left hand corner. 
o Insert Username:  Rumen 
o Insert Password:  Rumen 

 
- Verify the RoboCrib computer is viewing correct data. 

 
o Start the AutoCrib software by double clicking the 

shortcut available on the desktop. 
o Login to the AutoCrib software using „admin‟ as the 

username with no password. 
o Navigate to Tools > Options > Locations. 
o Verify the following: 

 
 Server:  Management Station pc Name\autocrib53 

(i.e. mgmtstation\autocrib53) 
OR 

Management Station IP Address\autocrib53 
(i.e. 192.168.168.24\autocrib53) 

 
 Database Name:  autocrib53 
 Username:  sa 
 Password:  AutoCrib2005 (This password will be 

encrypted.) 
o If the RoboCrib is not viewing the correct database, select 

“Edit” and enter the correct server name, database name, 
username, and password.  Then, select “OK”. 
 

- Exit the AutoCrib software. 
 

- Start the RoboCrib software by double clicking on the shortcut 
available on the desktop. 
 

- Once the RoboCrib software has started, allow the machine to 
calibrate. 
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Test Doors 
 
1. Using the RoboCrib software, insert the supervisor badge number 

and PIN.   

 If a supervisor has not yet been created, create a new 
employee in the Database > Employees module of the 
AutoCrib software and check “Supervisor” and “Stocker”. 

 
2. Select the Console button in the RoboCrib software.   

 At the command prompt, enter the “LON” command followed 
by each door number.  i.e. LON 01 to open door #1.  Continue 
until all doors are open. 

 
NOTE:  Bin Doors may be opened manually as shown.  The door 
should open with ease and the “open door” indicator light should 
illuminate until the door has been closed. 

 

 Due to movement during shipment, the alignment of the doors 
may have shifted.  If a door is not opening with ease, 
adjustments of the door will be necessary to ensure free 
operation.  Open the door panel and manually open the door. 
 
o Swing the door back and forth to loosen the spring. 
o Look to see if the plunger is aligned with the door latch.  If 

the alignment is off, adjust the door up or down depending 
on how the door shifted during shipment. 

o While the doors are closed, there should be an equal 
amount of space between the top and bottom of each 
door. 

o See further Bin Door troubleshooting documents in 
the Appendix. 
 

 Reassemble the front panel on the machine. 
 
Congratulations, you are ready to start stocking!!! 
 

 

STEP 4 – Create a purchase order 
- Use the Robo New PO tab.  This can be found in the Purchase 

Orders module within the Purchasing menu. 
- Select the crib, supplier, and method for reordering. 
- If all items should be ordered up to max, select “Purchase All”.  

Otherwise, insert the individual quantities into the Purchase 
field. 

- Once satisfied with the purchase quantities, click the „Apply‟ 
button. 

To actuate the solenoid, pull the “L” 
shaped, silver door latch to the right. 
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STEP 5 – Create a tag 
- Use the Create Tags tab.  This can be found in the Purchase 

Orders module within the Purchasing menu. 
- Select the Purchase Order number created in step 5 by double 

clicking in the aqua field. 
- If all items can be stocked, choose the „Receive All‟ or 

„Receive All Burn‟ button.  Otherwise, insert the individual 
quantities into the On Hand or Burn Qty fields. 

- Select the „Apply‟ button. 
- Print the Inventory Input Sheet – RoboCrib report located 

within the “Purchasing” report category of the Reports module. 
 
 

 STEP 7 – Stock RoboCrib 
- At the RoboCrib, insert the badge number and PIN.  (Note:  At 

least one employee must be setup as a stocker in the AutoCrib 
software.) 

- Select the Stock > Auto > Tag buttons. 
- Insert the tag number noted on the Inventory Input Sheet 

report. 
- The RoboCrib will prompt the following: 

o “Is tag complete?”  
 „Yes‟  all items on the tag are available for 

stocking. 
  „No‟  some, but not all items on the tag are 

available for stocking. 
o The RoboCrib will turn the platters until the first bin on 

the Inventory Input Sheet is in front of the door.   
 Once the door opens, place the appropriate 

item into the bin. 
 Close the door to stock the next bin. 
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Software Operations 
 
Manual Stock 

- At the RoboCrib, insert the badge number and PIN.  (Note:  At least one employee must be setup as a stocker in 
the AutoCrib software.) 
 

- Select the Stock > Manual buttons. 
 

- Search for the item.  Once the item is highlighted, select „Restock‟.  (The system will only show items where the 
quantity in the RoboCrib is less than the item maximum.) 

 
- The RoboCrib will prompt the following: 

o Insert the On Hand or Burn Qty to stock.  Then, select „OK‟. 
 

Automatic Stock by Tag 
- At the RoboCrib, insert the badge number and PIN.  (Note:  At least one employee must be setup as a stocker in 

the AutoCrib software.) 

- Select the Stock > Auto > Tag buttons. 

- Insert the tag number noted on the Inventory Input Sheet - RoboCrib report. 

- The RoboCrib will prompt the following: 

o “Is tag complete?”  
 „Yes‟  all items on the tag are available for stocking. 
  „No‟  some, but not all items on the tag are available for stocking. 

o The RoboCrib will turn the platters until the first bin on the Inventory Input Sheet is in front of the door.   
 Once the door opens, place the appropriate item into the bin. 
 Close the door to stock the next bin. 

   NOTE:  If the tag is not complete, you will be asked if the part can be fulfilled for each line on the tag.  
 

Physical by Bin 
- At the RoboCrib, insert the badge number and PIN.  (Note:  At least one employee must be setup as a stocker in 

the AutoCrib software.) 
 

- Select the Physical > Bin buttons. 
 

- Insert the Crib Number and Bin Number to physical. 
 

- After the RoboCrib retrieves the bin and the door opens, enter the correct on hand and/or burn quantities. 
 
NOTE:  If you make no changes to the physical counts, the system will default to the current on hand and burn 
quantities. 

 
Physical All Bins 
 

- At the RoboCrib, insert the badge number and PIN.  (Note:  At least one employee must be setup as a stocker in 
the AutoCrib software.) 
 

- Select the Physical > All buttons. 
 

- When prompted, move the bin door bypass switch to TEST. 
 

- Physically count the item(s) in the bins and document the quantities on the Physical by RoboCrib report located in 
the Reports module (Inventory category) of the AutoCrib software. 
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- When you have completed the physical on all bins within the column displayed, press the Next button.   

 
- Report process until complete. 

 
- Move the bin door bypass switch to RUN. 

 

  
Issue 
 

- At the RoboCrib, insert the badge number and PIN.   
 

- Select the Issue button. 
 

- Select appropriate responses from the blue validation tables.  (i.e. Department, Job, etc) 
 

- Click on the Item field and search for item using the item code, descriptions, class, or custom fields.  Press Enter. 
 

- The RoboCrib software will find the closest match.  Highlight the item you want and press the Issue button.   
 

- The software will retrieve the bin and open the door.  After removing the item, close the door and Logout of the 
software. 
 

Return 
 

- At the RoboCrib, insert the badge number and PIN.   
 

- Select the Return button. 
 

- Select the item you wish to return by either scrolling down, or search for the item.  Press Enter. 
 

- Highlight the desired item. 
 

- Insert the quantity being returned into the appropriate field; return, scrap, or regrind. 
 

- Place the item in the correct return location; regrind bin, active RoboCrib bin, or trash. 
 

- Note:  An item can only be returned to the RoboCrib if the crib has been designated as “returnable” in the 
AutoCrib software and the item being returned is a perishable, durable, or gage type item. 

 

Locate 
 

- At the RoboCrib, insert the badge number and PIN.   
 

- Select the Locate button. 
 

- Type in an item code or partial description of the item you wish to locate.  Press Enter. 
 

- The system will filter the database to the closest possible matches. 
 

- The crib and bin number will be displayed as well as the current on hand/burn inventory. 
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Troubleshooting the RoboCrib using the “Console” Button 
 

- At the RoboCrib, insert the badge number and PIN.  (Note:  At least one employee must be setup as a supervisor 
in the AutoCrib software.) 
 

- Select the Console button. 
 

- To call a bin, type FET BBB P (B is for Bin Number, P is for Baffle Position).  i.e.  FET 21L 3 will call bin 21L and 
set the baffle position for a fourth pie. 
 

o Baffle Positions (P) are as follows: 
 (1) = twelfth pie 
 (2) = sixth pie 
 (3) = fourth pie 
 (4) = third pie 
 (5) = half or full pie 

- Once the bin has been positioned in front of the doors, you must open the door.  LON DD (D is for door number).  
I.e. LON 15 will open door 15. 

- An invalid bin number will return an error (E2).  If the tray configuration is unknown, please refer to the number 
scheme provided at the time of installation. 

- Other commands that can be used: 

o RSA (Report Status All):  If system is calibrated and all doors are closed, the system will report back 
“OK”.  If a door is open, the system will report back “DO”. 

o CAL M or CAL L:  moves the main platter or LSP one complete clockwise revolution. 

o TST M or TST L:  moves the main platter or LSP one complete counter clockwise revolution. 

o To view more controller commands, please reference Appendix I. 
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Commonly Performed Procedures 
 

- Perform a Calibration Sequence.  (This will be performed automatically every time the RoboCrib software is 
restarted). 

o Restart the RoboCrib software. 

o Select “OK” when prompted to calibrate the machine 

- Exiting RoboCrib software on the touch screen to access the Microsoft Windows desktop. 
o Ensure the RoboCrib software is in the main login screen. 

o Double click on the AutoCrib logo in the upper left portion of the screen. 

 Insert the Exit username and press “OK” 

 Insert the Exit password and press “OK”. 

NOTE:  If an Exit username and password has not been setup, go into the Tools > Security module of the 
AutoCrib software and create a new user. 

 

- Proper Loading Procedure 
o Before installing the RoboCrib, use the test pies to select a proper bin size for the items. 

o ITEMS MUST NOT PROTRUDE FROM BIN TRAY PERIMETERS!  Therefore, if an item does not fit 
easily into the bin, choose a large bin size. 

o Print the “Reorders by RoboCrib” report which is found in the Standard Reports module within the 
Purchasing report category. 

o Create a purchase order and a tag for the RoboCrib. 

o Print the “Inventory Input Sheet – RoboCrib” report which is found in the Standard Reports module within 
the Purchasing report category. 

o The proper bins will align to the door.  The RoboCrib program will display the item and the bin it is 
assigned to.  Once the bin has been stocked, close the door.  The RoboCrib program will display the next 
item to be stocked and the bin it is assigned to.  Continue this process until the stocking procedure has 
been completed. 

o The process may be cancelled at any time.  The tag will still apply to all items that have not been stocked.  
When ready to restart the stocking process, follow the same procedure as above.  (The RoboCrib will 
start with the next bin on the tag.) 

o IMPORTANT:  The stocking screen does not timeout.  Therefore, make sure the main login screen is 
present once the restocking procedure has been completed. 

o DO NOT USE THE MANUAL SWITCHES TO RESTOCK!!! 

 
- Removing Walls 

o The panels are keyed in a clockwise sequence beginning with the Bin Door panel. 

o Exception:  the Right Front Panel can be removed independently. 

o To remove the screws from the panels, you must use a pin-in-hex 5/32 hex driver and a 7/16 socket 
driver. 

o Once the screws have been removed, lift the panels up to disengage the keys. 

o To replace the panels, replace the right rear panel first and proceed counterclockwise. 

o Make sure to set the bottom edge of each panel in the channel on the frame. 

- Console Mode  (Instructions on the use of the Console function can be found under Software Operations) 
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o Times when the Console mode may be used are: 

 Access items from the machine in an emergency or for testing purposes 

 Rotate platters 

 Open doors 

 Perform other basic tasks without using the RoboCrib software 

 To ensure the machine is operating normally on initial installation of the machine. 

 To ensure a bin has been setup properly and has an item inside it. 

 While lubricating a chain, you may want to have the platter move. 

 Troubleshoot a specific problem with the machine 

o When the Console mode is being used, no changes are made to the AutoCrib databases. 

o Machine can move and open its bin access doors. 

 
- MTTTY  (The MTTTY program should only be used when the RoboCrib software will not start) 

o Exit the RoboCrib software. 

o Launch the MTTTY program from the desktop. 

o Select the File menu  Com Port  Select COM2  Connect 

o The software will position a black cursor in the lower left of the editor screen. 

o To fetch a bin, type FET BBB P (B is for Bin Number, P is for Baffle Position).  I.e. FET 21L 3 will call bin 
21L and set the baffle position for a fourth pie. 

o Baffle Positions (P) are as follows: 

 (1) = twelfth pie 

 (2) = sixth pie 

 (3) = fourth pie 

 (4) = third pie 

 (5) = half or full pie 

o CAL M or CAL L:  moves the main platter or LSP one complete clockwise revolution 

o TST M or TST L:  moves the main platter or LSP one complete counterclockwise revolution 

o To view more Controller commands, please reference Appendix I. 

Note:  Under normal circumstances, the Maintenance function should be used.  In an instance where the 
RoboCrib software has locked up, the MTTY may be necessary to troubleshoot problems or call bins.   
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Troubleshooting Common Problems 

Install or replace the touch screen display – Model C Only 
 

- To remove the Display Assembly: 
o Remove the Right Front Wall.  This allows access to the display controller. 

o Detach the DB9 cable and the power cord from the controller. 

o Remove the wing nuts/nylocks that hold the display assembly to the Vertical Z channel. 

o The entire display comes straight out. 

 Take care to protect the screen. 

 Note the keyboard drawer slides freely. 

- To replace the Display Assembly: 
o Align the mounting studs with the marked holes in the Vertical Z channel. 

o Attach and tighten the wing nuts. 

o Attach the DB9 cable and power cord to the controller module. 

o The RoboCrib computer will have to be configured for the network.  See Installation Section – Step 3. 

 
System will not Calibrate 
 

- The RoboCrib will automatically begin the calibration procedure when the RoboCrib software is started. 

- If the machine is unable to calibrate, the software will provide the user with an error message.  Please refer to 
Appendix II. 

 

Software will not Initiate the Calibration Sequence 
 

- Verify all doors are closed or set the bin door bypass switch to TEST. 

- Controller power switch should be “ON”. 

- Ensure the RoboCrib and Management Station is connected to the network. 
 

RoboCrib will not Dispense 
 

- Verify all doors are closed.  If doors appear to be closed, but the system thinks a door is open, set the bin door 
bypass switch to TEST. 

- Controller power switch should be “ON”. 

- Ensure the DB9 cable is connected from the controller to the computer‟s COM2 port 

- Verify there are no COM port conflicts in the Device Manager. 

- If the MTTTY software is launched, the RoboCrib software will not connect.  The software will produce errors if the 
RoboCrib program is started. 
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Manual Switches are not Operational 
 

- Remove the Right Front panel. 

- Manually rotate the Main platter with your hands until you have access to the LSP motor. 

- Remove the protective box cover from the motor.  Drive the motor back shaft (see diagram below) until you are 
able to access the correct tray assembly or small platter motor. 

 

Bin Door will not Open 
 

- Remove the bin door cover panel. 

- Manually open the door by pushing on the solenoid shaft. 

- Check the alignment of the doors. 

- Clean out any debris found inside the door.  Used compressed air if necessary. 

- Check the ribbon cable connection. 

- Verify other doors work properly. 

- Replace a non-function assembly with a known good assembly. 

 

Replacement of Controller 
 

- Remove the Right Front panel section so that the display and controller are accessible. 

- Disconnect the door wiring, motor wiring, sensor wiring (on top of the controller), DB9 cable, and power cable 
from the computer. 

- Remove the controller panel door. 

- Remove the four screws that hold the control panel to the vertical Z channels. 

 

Chain needs to be remounted because it has broken or come off of the gears. 
 

- Position the platters at their home position, column 111. 

- Through the holes in the LSP, align the threaded holes in the Main Platter. 

- Lock the LSPs to the Main Platter with 5/16-18 x 3-1/2 bolts. 

- Loosen the motor mounts and reinstall the chain. 

- Tighten the motor mounts, remove the bolts, and adjust the tension. 

 

If you are unable to get platters to 
move, you may take a cordless drill, 
gently chuck on the motor backshaft, 
and drive the motors until you have 
moved the desired bin to the access 
location.  This is helpful in the event of 
a power outage.  
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Problem:  Receiving a jam or stall error, Finding dropped items 

 
1. Locate Source of Jam from Front Door 

 

 Open the right front door with the key by turning both locks counterclockwise. 

 Remove the left door hold-down screws using a #1 Phillips driver. 

 The left door will swing open.  The bin doors and baffle assembly are mounted to the door, unlike 
other RoboCribs. 

 
 

 
 

NOTE: THE MOTORS WILL TURN AND THE BINS WILL MOVE WHEN THE LEFT DOOR IS OPEN.  ALWAYS 
EXERCISE CAUTION WHEN REACHING INTO THE MACHINE OR USING THE MANUAL SWITCHES WHEN THE 
LEFT DOOR IS OPEN. 
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2. Alternative Methods to Locate Jam 
 
 If the source of the jam cannot be located from the front, use the key to open the top cover. 

 Using a flashlight, look between the stacks to see if the source of the jam can be found. 

 Turn motors manually. 
i. Use the SSP motor switch to turn the SSP motor 360 degrees. 
ii. Use the LSP motor switch to turn the LSP 360 degrees. 
iii. If at any time, the motors do not turn freely, reverse the direction, and try again.   

 If the jam still cannot be located or the dropped item cannot be reached from the front or top, remove 
the right access panel using the 5/32 pin-in-hex driver to remove the security screws. 

 

 
 

3. Issue from RoboCrib 
 
 Once the jam has been cleared, rotate the LSP and SSP motors 360 degrees to verify the stacks are 

not being impeded. 

 Replace the rear panel, close the left door, and replace the door retaining screws. 

 Close the right door and secure with the locks. 

 Start the software and allow the machine to go through the calibration process. 

 Perform a test issue from the RoboCrib. 
 
NOTE: IT IS ACCEPTABLE TO RUN THE MACHINE WITH THE LEFT DOOR RETAINING SCREWS MISSING, BUT 
WE RECOMMEND THAT WHENEVER THE DOOR IS CLOSED, YOU REPLACE THE SCREWS. THE SCREWS MUST 
BE IN PLACE WHEN THE MACHINE IS BEING MOVED OR SHIPPED. 
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Problem:  Motors will not turn or LEDs on controller do not light or flash as they should 

 
1. Check wiring 

 

 Open the top cover with the key and check the wiring at the top of the controller. 

 The connectors should be centered on their heads and seated completely. 

 If the headers are properly in place, use a voltmeter or continuity tester to verify the continuity of each 
lead back to its corresponding pin at the motor location.  Call AutoCrib technical support for 
assistance. 

 

 
 

 
The headers and corresponding systems are: 
H1 – BAFFLE – 5 PINS –WHITE, BROWN, BLUE, (NONE) RED, BLACK 
H2 – LSP – 8 PINS – RED, WHITE, BLACK, GREEN, BLUE, NONE, ORANGE, BROWN 
H3 – BIN DOORS – 26-PIN RIBBON CABLE 
H4 – SSP – 9 PINS – ORANGE, WHITE, BLUE, GREEN, BLACK, NONE, NONE, RED, 
BROWN 
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Problem:  Door Does Not Open 

 
1. Verify Power is OK 

 

 The RoboCrib should be plugged into an active power outlet; the UPS status light should be green 
not beeping. 

 Verify the RoboCrib power cord is plugged into UPS 

 Verify sure controller lights are on 
i. If the controller is not on, recheck power, switch OFF, wait 5 seconds, switch ON. 

 Attempt to dispense using the RoboCrib software.  If the RoboCrib dispenses correctly, there is no 
further troubleshooting that needs to take place. 

 
2. Use the RoboCrib software to open the door 

 
 Login to the RoboCrib software as a supervisor.  Select the Console button. 

 Actuate the door by sending the open door command in the Console screen. 
o LON ##   ## - Representing the door. 
o If the door opened, attempt to issue a tool through the RoboCrib software.  If the RoboCrib 

dispenses correctly, there is no further troubleshooting that needs to take place. 
o If the door did not open, check the ribbon cable connection at the top of the controller in header 

H3.   
 Remove the left door screws and open the left door. 
 Check the ribbon cable connection at the top center of the left door. 
 Verify each connector on the ribbon is seated firmly. 

 

 
 

RIBBON CABLE BACKBONE CONNECTION 

 

 

 

TOP BAFFLE WHEEL ASSEMBLIES 

 

 

 

 

RIBBON CABLE CONNECTION TO DOOR 

LATCH 
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o If the ribbon cable is connected properly, verify the other doors will open using the LON 
command. 
 If no other doors will open, there is a problem with the communication between the 

controller and the computer.  Turn off the computer and the controller.  Wait 5 seconds.  
Then, turn the controller back on and then turn the computer on.  Reattempt steps (a) and 
(b). 

 If the faulty door opens after attempting the LON command, attempt to issue through the 
RoboCrib software.  If the RoboCrib dispenses correctly, there is no further 
troubleshooting that needs to take place. 

 
 Manually Open the Door 

 
 Open the front panel. 

 Remove the solenoid cover from the door. 

 Open the door by pulling the manual release lever.   

 If the door opens without tension, try re-positioning the jumper. 
o Turn the controller off. 
o Move the jumper into position 1 and remove the jumper on door 1. 
o Turn the controller on. 
o Using the Console screen, attempt to open the door using the LON 01 command. 
 If the door opens, replace both jumpers into the correct position.  Attempt to issue through the 

RoboCrib software.  If the RoboCrib dispenses correctly, there is no further troubleshooting 
that needs to take place. 

 If the door does not open, use the spare door supplied with the RoboCrib.   
- Turn the controller off. 
- Remove the entire door. 
- Place the jumper on the appropriate pin of the new door. 
- Install the new door and attach ribbon cable. 
- Turn the controller on and attempt to issue through the RoboCrib software. 
- If the RoboCrib dispenses correctly, contact AutoCrib technical support to receive a 

replacement door. 
- If the RoboCrib does not dispense correctly, contact AutoCrib technical support for further 

troubleshooting. 

 Follow the steps below if the door opens with tension.  The door may need to be realigned or debris is 
blocking the solenoid. 
o Remove any debris blocking the door. 
o While closing the door look at the tab as it enters the bracket.  Make the necessary adjustments 

until the manual release lever has a fluid motion while opening the door. 

 If the door does not open, the solenoid standoff has fallen off and needs to be placed back on the 
solenoid plunger. 
o Remove the cover bracket over the LED light. 
o Locate the plastic standoff and place it back on the plunger. 
o Replace the cover and attempt to operate the door as usual. 
o If the door cannot be opened, use the spare door supplied with the RoboCrib. 
 Turn the controller off. 
 Remove the entire door. 
 Place the jumper on the appropriate pin of the new door. 
 Install the new door and attach ribbon cable. 
 Turn the controller on and attempt to issue through the RoboCrib software. 
 If the RoboCrib dispenses correctly, contact AutoCrib technical support to receive a 

replacement door. 
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Problem:  The LED on Door Remains On 

 
1. Adjustment of the front-side solenoid encoder 

 
 Turn the controller off. 

 Remove the left door screws and open the left door. 

 Open the door by pulling the manual release lever. 

 Remove the solenoid cover bracket. 

 Adjust the front encoder (U4 position on the board) that is next to the LED light to the right. 
o Use a non-magnetic flathead screwdriver and place it in between the encoder and the plunger 

guide wall. 
o Push off the plunger guide wall gently and adjust the sensor towards the right. 
o Turn the controller on and close the door.  If the LED turned off, attempt to issue from the 

RoboCrib.  If the RoboCrib dispenses correctly, no further troubleshooting is required. 

 
2. Adjustment of the back-side solenoid encoder 

 
 Turn the controller off. 

 Adjust the back encoder (U3 position on the board) that is behind the solenoid against the back wall 
of the door. 
o Use a non-magnetic flathead screwdriver and place it in between the encoder and the plunger 

wall. 
o Push off the back part of the wall gently and adjust the sensor toward the front or towards the 

user. 
o Turn the controller on and close the door.  If the LED turned off, attempt to issue from the 

RoboCrib.  If the RoboCrib dispenses correctly, no further troubleshooting is required. 
o If the LED does not turn off, use the spare door provided with the RoboCrib.  Contact AutoCrib 

technical support to receive a replacement door. 
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Problem:  Open Door error message or LED does not turn on when door is open 

 
1.  Test all doors using Console screen 

 
 Login to the RoboCrib software as a supervisor and select the Console button. 

 Actuate each individual door by using the LON ## command (## - Representing the door number) 

 If all LED lights turn on when the door opens, continue troubleshooting steps.  Otherwise, use the 
spare door provided with the RoboCrib. 

 
2. Manually test the doors 

 
 Turn the controller off. 

 Remove the left door screws and open the left door. 

 Detach the ribbon cable from door 1. 

 Turn the controller on. 

 Verify the door switch is in the Run position. 

 Restart the RoboCrib software.  If the machine calibrates successfully, the faulty door has been 
located.  Replace this door with the spare provided with the RoboCrib.   

 If the RoboCrib cannot calibrate, continue with the steps below. 
o Turn the controller off. 
o Reattach the ribbon cable to the door. 
o Unplug the next door. 
o Turn the controller on. 
o Restart the RoboCrib software.  If the machine calibrates successfully, the faulty door has been 

located.  Replace this door with the spare provided with the RoboCrib. 
o If the RoboCrib cannot calibrate, continue with steps (i) through (v) to find the problematic door.  
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Preventative Maintenance 

Your RoboCrib has been designed to give you years of reliable service with a minimum amount of maintenance.  
However, some minor preventative maintenance is required to keep the system running in peak condition.  Below we 
have listed the tasks that should be performed at periodic points to ensure the system performs at peak operating 
efficiency.      

 

Cleaning Exterior Surfaces 
 

- Sheet Metal Surface 

o 16 gauge sheet metal finished with diamond texture power coat. 

o The surface is rugged and shop hardened to stay appealing to the eye for years. 

o As dirt and grease accumulate on the surface, the machine should be wiped with a lint free rage and 
Simple Green or Formula 2001.  (AutoCrib suggests Formula 2001) 

- Windows 

o The Plexiglas viewing windows should be cleaned with Windex or a different type of window cleaner. 

o DO NOT USE any other product on the windows as it may scratch or stain the window surface. 

- Keyboard 

o Clean the keyboard with a keyboard cleaner. 

o DO NOT place any liquid into the keyboard.  This may damage the internal workings of the keyboard. 

o AutoCrib suggests cleaner be applied to a rag before wiping the keyboard. 

- Touch Screen 

o Wipe the screen with a clean, soft rag. 

o 409 or a glass cleaner can be used on the rag. 

o Never spray directly on the touch screen membrane.  This could damage or short the membrane. 

o Replaceable plastic screen covers are available to protect the glass 

 

Hardware – After 30 Days 

- Bin Doors 

o Open every bin door using the LON command. 

o Make sure the hinges and actuation systems are not binding up.  If they are not working properly, make 
the necessary adjustments to ensure free operation.  Lubricate with WD40 to flush out contaminants and 
eliminate binding. 

- Door Solenoids: 

o Inspect the door solenoid harness to ensure the wiring harness is not loose. 

- Main Platter Chain 

o The tension in the chain should have about a ½” of play. 

o It is normal for the chain to stretch within the first thirty days.  If the system is loaded with a large amount 
of weight, the chain may stretch more. 

o Tighten the adjuster bolt on the chain tensioner until you have the correct amount of play.  Apply a Dry 
Chain Lube to the chain. 
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o Repeat this process for the LSP and the 3 SSP chains.  These chains are adjusted by loosening the 
motor mount bolts.  Tighten the chains by moving the motor mounts outward. 

 

Hardware – After 1 year and every year thereafter 
 

- Keep bin doors free of build-up 

- Clean the touch screen – DO NOT SPRAY DIRECTLY ON SCREEN!!! 

- Check for dropped product on the Main platter 

- Check and adjust the tension on the chains 

- Lube (dry lube only) the chains, sprockets, door hinges, latch assemblies, and plastic bearings. 
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RoboCrib Technical Specifications 

RoboCrib External Parts 
 

- Frame 
o A 2” steel tube frame supports a chain drive system, which actuates 12 individual platters. 

o The frame is 62” wide, 62” deep, and 83” high (including wheels). 
 

- Wheels 
o Omni-Directional 

o Non-Locking 

o Leveling footpads are included with the shipment of the RoboCrib if using the wheels is not preferred. 
 

- Walls 
o Made from 16Ga steel 

o Sit in a channel, lock together with interlocking tabs, and attach to the frame by pin-in-hex tamper-
resistant screws. 

o Types of Walls: 

 Right Front and Left Rear corner panels (2 each) 

 Right Rear and Left Front corner panels (2 each) 

 Back Panels (2 each) 

 Front Bin Door Panel (1 each) 

 Vertical Z Channel (2 upright rack mount rails) which holds the: 

 Control Panel 

 Touch screen Assembly 

RoboCrib Platters 
 

- Main Platter (MP) 
o Large Center Platter 

o 4‟ 8” diameter 

o Driven by the main platter motor and chain 
 

- Large Sub Platter (LSP) 
o Three platters each with 3 small sub platters 

o 1‟ 8” diameter 

o The LSP motor and chain drive the 3 large sub platters and the 01X, 02X, and 03X small sub platters. 

o The LSP chain is also called the “serpentine” chain. 
 

- Small Sub Platters (SSP) 
o Nine 10” diameter sprockets 

o Located on the three large sub platters 
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Drive System 

 
- Motors 

o Electric Gear Motors 

o 3 sizes 

 Main Motor (1 each) 

 Large Sub Platter Motor (1 each) 

 Small Sub Platter Motor (3 each) 

- Encoders and Position Sensors – Hall effect slotted interrupts 
o Encoders 

 Main and Large Sub Platter:  located on the motor backshaft 

 Small Sub Platters:  located on the sprocket teeth 

o Position Sensors and Reference Marks 

 Main Platter:  located on the perimeter 

 Large Sub Platter:  located on the 03X platter 

 Small Sub Platters:  one is located on each of the 11X, 21X, and 31X platters. 

- Chains 
o Main Platter is tensioned at the motor mount.  There is about an inch deflection. 

o Large Sub Platter and the Small Sub Platters are tensioned at the motor mount. 

- Wiring 
o There are two cables per system 

 Motor Driver 

 2 cond. 18 AWG Stranded BW 

 2 Attached with .093 pin and socket connectors 

 Signal 

 5 cond. 22 AWG Shielded 

 Attached with Straight Line 156 connectors 

 Slip Rings – Replaced the Wire Wind-Up indicators for MP and LSP 

 1 ea for Center Post – 24 conductor 

 3 ea for LSP Posts – 7 conductor 

 These serve the Motor and Signal wiring for the LSP and SSP motors 

Posts, Hex Shafts, Mounting Arms, and Tray Assemblies 

 
- Main Post 

o The large center support post with top and bottom mounting collars. 

o Houses the wiring for the Large Sub Platter motor. 

o Supports the three Large Sub Platter arms and the three Small Sub Platter arms. 

- Large Sub Platter Posts 

o There is one post per Large Sub Platter with top and bottom collars. 

o Houses the wiring for the Large Sub Platter and Small Sub Platter arms. 
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- Hex Shafts 

o The machine contains 3 long hex shafts and 9 short hex shafts. 

o Support the trays and dividers. 

 Permanently oriented to position sensors by the center pins of the sprockets 

 Bearings are stock UHMW polyethylene.  These can be replaced if necessary. 

o Mounting Arms 

 There are 3 on each RoboCrib 

 The flat head screws allow the tray assemblies to be removed and replaced. 

 

Calibration and Alignment 

 
- Shafts, sprockets, and sensor points are permanently oriented to each other at the factory. 

- Alignment is set in the controller firmware. 

- The system counts pulses from the position sensors and encoders, which are located on the platters.  The system 
compares these pulses to ideal position data stored in the Controller, then calculates the actual position and 
reports position information to the computer. 

- The calibration sequence resets the “home” position for the RoboCrib program to bin 111. 

NOTE: If bins do not align correctly, contact AutoCrib for instructions on fine-tuning the machine. 
 

Bin Doors and Baffle Assemblies 

 
- Bin Doors: 

o There are 15 levels of delivery doors. 

o Each door has an LED indicator, which light red when the door is sensed to be open or unlatched. 

o The doors are spring-loaded and are latched by a solenoid assembly. 

o The doors will open after the fetch command has been completed. 

o The doors have a safety switch interlock. 

 Prevents the system from turning when a door is open. 

 The door switches can be over-ridden by moving the bin door bypass to “TEST”. 

- Baffle Assembly 

o The moveable baffles adjust according to the size of the bins. 

o The baffle assembly is protected by a slide pot assembly that converts its absolute position into a signal, 
which is sent to the controller.  This signal is used to position the baffle doors and calibrate at start-up. 

o The baffle assembly can be removed and replaced.   
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Appendix I 
 

RoboCrib Controller Commands 

 

PC Command         Description           Response           Comments 

TST [M/L/S] Test 

M – Main Platter 
L – Large Subplatter 

S – Small Subplatter 

W – wrap count decremented by 1 from previous value 

d – direction always =-1 
r – ref error is internal position when ref mark encounter as platter moves CCW  

e –value reported has no meaning for this command 

s – stall error values have same meaning as FET 

TST commands always turn 

motors counter clockwise 
(CCW) when looking into 

backshaft of motor. 

CAL [M/L/S] Calibrate 

 

w – wrap count set to 1 

d – direction always =1 

r – reference error has no meaning for this command 
e –value reported has no meaning for this command 

s – stall error values have same meaning as FET 

CAL commands always turn 

motors clockwise (cw) when 

looking into backshaft of 
motor. 

RSA Request Status All Returns status of all platters using codes shown above for FET  

RDS Request Door Status DO-Pxxxx – Door Open where xxxx is HC11 internal MP position in hex 
DC – Door Closed 

 

RCS Request Calibration 

Status 

CC – Calibration Complete – all platters OK 

CI – Calibration Incomplete – some or all platters not calibrated 

CE – Calibration Error – at least 1 platter has reported a “c-n” error 

 

LON nn Activate Solenoid nn  Solenoid nn activated, all other solenoids deactivated  

LOF Deactivate Solenoids All solenoids deactivated  

RVN Read Version Number Returns the version number and date of the HC11 software.  
 

Note: All values are decimal unless otherwise noted. 

 

 
 

 

 

  

  

 

 

   

FET abc d Fetch command 
abc-Bin to be fetched 
 
a-LSP number 
b-SSP number 
c-Bin number on 
platter 
d-Baffle position 

c – calibration status 
  0-not calibrated since power on 
  1-calibrated 
  -2-encoder B error so internal position is wrong 
  -3-platter reference mark not detected so wrap count may be wrong 
  -4-platter reference mark was detected but was not within ref error limit 
  -5-baffle pot voltage out of range 
w – wrap count (0 or 1) 
d – direction (1 for cw/ -1 for ccw) 
r – reference error reported when passing ref mark 
e – position error between targeted vs actual position 
s – stall errors 
  1 platter never moved or sensors not connected 
  2 platter started to move, then stopped 
  3-xxxx platter speed too slow during full-speed part of move 
  4-xxxx unexpected platter decel during full-speed part of move 
  5-door open kept platter from moving or stopped it during move 
  6-baffle motor not working/baffle jammed/pot bad 
  7-wrap pot voltage limit hit – power to MP/LSP motors cut 
  8-xxxx platter stall check right after power to motor 1

st
 check pt. 

  9-xxxx platter stall check right after power to motor 2
nd

 check pt. 
where xxxx is the stall value that caused the stall 

The stall values can be 
adjusted using the CSn 
commands.  If a stall 
recurs several times 
without an obvious cause, 
the stall value should be 
increased.  However, 
increasing the value too 
much may keep the 
platter from stalling when 
it should. 
 
An s7 error means that 
both MP and LSP motor 
power has been turned 
off regardless of which 
platter has exceeded the 
voltage limit.  Use 
maintenance panel lights 
and switches to get the 
offending platter back 
within legal limits. 
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Appendix II 

 

 

Explanation of Errors on a RoboCrib 

 

Calibration Errors  

 

C Code  Error  Action  Message  

C0 Not calibrated 

Since start up  

Check pot voltage for wind 

Count and recalibrate. 

“Recalibrating          

  Please Wait” 

    

Notes:  This error will occur any time the machine is started or on a power loss to the controller.  On normal 

operation, the Touch screen will display an error noted above and check the pot voltages.  The machine will 

make a series of “CAL” or “TST” commands until the system detects the machine in an unwound condition.  

This can be confirmed by the wind indictor lights on the main controller.  Both the LSP and MP lights should be 

in the middle position “Green”. 

 

C Code  Error  Action  Message  

C1 Status OK.   

All systems Go  

  

None system ready for fetch commands. None     

  ” 

 

Notes:  This is the normal operating condition. 

 

C Code  Error  Action  Message  

C2 Encoder 

B Error  

Check wind count and attempt to recalibrate 3 

times, if unsuccessful system will lock touch 

screen and display error. 

“Encoder B not working 

on platter X See 

supervisor” 

 

 

Notes:  Encoder B errors can be caused by a number of things.  The most common causes are follows:  

1. The drive chain on affected platter is too tight causing an oscillation on start up of the motor.  The 

paddle wheel on the back shaft of the motor moves oscillates in both directions at a slow rate of speed 

through the optical reader causing the encoders to give a false reading.    

2. The drive chain on affected platter is too loose causing an oscillation on deceleration to called position.  

The paddle wheel moves or oscillates in both directions at a slow rate of speed through the optical reader 

and gives a false reading. 

3. A hard Jam causes the machine to stop suddenly causing oscillation in the paddle wheel.  
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C Code  Error  Action  Message  

C3 Platter Ref 

mark not 

detected. 

Check the wind count and Attempt to 

recalibrate 3 times with no error.  If 

unsuccessful throw error and lock touch 

screen.  

“Ref Tab not detected on 

platter X see supervisor” 

 

Notes:  When a C3 error occurs, the affected platter did not detect the magnetic indicator on the platter (MP) or 

the chain.  This can be caused by damage to the indicator or the magnetic pickup.  If this happens the controller 

can no longer store its wind count to volatile memory. The C3 error stops this from happening.  If this occurs 

one should check the ref mark indicator lights on the controller (red LED). The MP led should light when the 

Ref tab passes the magnetic pickup.  

On all other platters, the indicator light should stay on until the Ref tab passes magnetic or optical pickup.  If 

this does not occur, the machine may have wiring problem or a bad controller.   

 

C Code  Error  Action  Message  

C4 Platter Ref 

mark was 

detected but 

not with the 

Ref error 

limitation.  

Check wind count and Attempt to 

recalibrate 3 times with no error.  If 

unsuccessful throw error and lock touch 

screen.  

“Ref Tab not detected on 

platter X see supervisor” 

  

 

Notes: A C4 error is caused by a condition where the machine has rotated more than 84 pulses past where it 

expected to see the Ref mark on the affected platter.  This can be caused by a missing Ref tab or more likely the 

use of the manual platter movement switches.  If a user moves the platter in a direction that would move it pass 

the ref tab and then the machine fetches a bin in the opposite direction that condition could occur where the 

machine would detect more than the limiting pulses.  The machine will normally self correct this condition by 

recalibrating.  

 

C Code  Error  Action  Message  

C5 Baffle pot 

voltage out 

of range.  

None then lock the touch screen.   The 

administrator must use manual switch to 

move to position 1 check the rack and 

pinion and then perform a “CPR B” 

Command from the maintain screen.   

“Baffle over traveled See 

supervisor” 

 

Notes:  A C5 error normally occurs when the baffle motor overdrives the pinion on the rack.  Once this 

happens, the user must check the rack and pinion to see if any damage has occurred.  If the pinion is still 

engaged on the rack, the system administrator should use the manual baffle switch to position 1 or the 12
th

 pie 

configuration setting.  Next, the administrator should use the Maintain screen on the touch screen to reset the 

baffle pot voltage.  The command used to do this is “CPR B” once this has been completed, the machine should 

be restarted to force a calibration.   
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Jam Errors  

 

S Code  Error  Action  Message  

S1 Platter never 

moved or 

sensors not 

connected.  

1. Take no action  

2. Throw error  

3. Lock the screen.     

“Motor/Sensor 

unresponsive on platter X  

See Supervisor” 

 

 

 

 

 

 

 

 

 
 

 

 

 

Notes:  This error occurs normally when a motor is not functioning or disconnected or it’s sensors / encoders 

are not functioning and will occur at the beginning of the fetch cycle (see diagram above) .  The administrator 

should check the connections first.  Everything appears normal; the next step would be to begin changing the 

components with a functioning platter to identify the problem part.  

 

 

 

Speed 

Time  

Accel.  

Ramp 

                 Move Cycle 

Decel.  

Ramp  

S1 

Full speed part  

Of move 

Check 1 

Check 2 

Fetch Begins Fetch Ends 
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S Code  Error  Action  Message  

S2 Platter 

started to 

move then 

stopped/.  

1. Take no action  

2. Throw error  

3. Lock the screen.     

“Motor/Sensor 

unresponsive on platter X  

See Supervisor” 

 

 

 
Notes: An S2 error is typically caused by one of 2 conditions.  

1. The system begins to turn the platter but encounters a hard Jam (something stuck in the chain etc.).  In 

this case, the administrator should remove the side panel of the machine and inspect the affect platter 

and chain for any possible obstructions.  If there are none the next step should be to attempt to move the 

platter with the manual switches.  If the machine will moves then proceed to the step 2  

2. The other possible condition is the sensors/encoder is not reporting the movement or pulses back to the 

controller.  This will cause the machine to stop immediately after it starts.  The administrator should 

check all connections and proper functioning of the sensors.  

 

 

 

 

 

Speed 

Time  

Accel.  

Ramp 

                 Move Cycle 

Decel.  

Ramp  

S2 

Full speed part  

Of  move 

Check 1 

Check 2 

Fetch Begins Fetch Ends 
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S Code  Error  Action  Message  

S3 Platter too 

slow during 

full speed 

part of the 

move.  

1. Take no action  

2. Throw error  

3. Lock the screen.     

“Possible Jam on Platter r 

X  See Supervisor” 

 

 

 

 
Notes:  An S3 error is usually a soft jam and is caused by an item that is pinched between the chain and a 

sprocket.  This almost always happens on the LSP or serpentine chain.  The administrator should remove the 

side panel and inspect the chain for any obstructions.  Clear any obstructions and restart the machine so it 

recalibrates.  

 

 

 

 

 

 

 

 

 

 

 

Speed 

Time  

Accel.  

Ramp 

                 Move Cycle 

Decel.  

Ramp  
S3 Full speed part  

Of  move 

Check 1 

Check 2 

Fetch Begins Fetch Ends 
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S Code  Error  Action  Message  

S4 Unexpected 

Platter 

deceleration 

during full 

speed part of 

the move. .  

1. Take no action  

2. Throw error  

3. Lock the screen.     

“Possible Jam on Platter r 

X  See Supervisor” 

 

  

 

 

 
 

Notes: An S4 error indicates a hard jam.  This occurs when something stops the machine very quickly as 

opposed to just slowing it down in a soft jam condition.  The administrator should remove the side panel and 

inspect the machine for any obstructions.  Clear the obstructions restart the machine forcing a recalibration.  

 

 

 

 

 

 

 

 

Speed 

Time  

Accel.  

Ramp 

                 Move Cycle 

Decel.  

Ramp  
S4 Full speed part  

Of  move 

Check 1 

Check 2 

Fetch Begins Fetch Ends 
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S Code  Error  Action  Message  

S5 Door opens 

during Platter 

movement.  

1. Throw error  

2. Wait for door to close  

3. Refetch the called Bin  

“Close the lighted door” 

 

  

 

 

 
 

Notes: An S5 a door open error is caused by a bin door popping open during platter movement.  The system on 

detection will immediately stop the rotation of all platters as a safety hazard has occurred.  The user only needs 

to close the door.  The system will automatically refetch the called bin.  These conditions are normally caused 

by an incomplete latching of a door by the previous user.  Instruct the user to retrain the users on proper door 

closure.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Speed 

Time  

Accel.  

Ramp 

                 Move Cycle 

Decel.  

Ramp  
S5 Full speed part  

Of  move 

Check 1 

Check 2 

Fetch Begins Fetch Ends 
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S Code  Error  Action  Message  

S6 Baffle not 

working or 

jammed.  Pot 

is bad  

1. System moves to position 5  

2. Refetch the called Bin 

3. If still S6 then throw error and lock 

screen  

“S6 Baffle Jammed  

See Supervisor” 

 

  

 

 

 
 

Notes: An S6 “Baffle Jammed” error is caused by one of three things: 

1. Something has fallen or been placed between the baffles, jamming the system 

2. The slide potentiometer is bad or broken.  

3. Baffle motor is not working.  

 

When this occurs, the system will automatically move to position 5 or the outer most position and then 

refetch the bin, in attempt to clear the jam.  If it fails on this attempt, the system will abort and throw the 

baffle jam error.  If this occurs a system administrator must clear the clear the jam by manually actuating the 

door and clearing the jam.  After the jam is cleared the supervisor should manually position the baffle to 

position 1 or the innermost position and run the   “CPR B” command, which will reset and calibrate the 

slide potentiometer.  If procedure fails, you should check proper operation of the motor and slide 

potentiometer.  

 

  

 

 

 

Speed 

Time  

Accel.  

Ramp 

                 Move Cycle 

Decel.  

Ramp  

sS

s6 

Full speed part  

Of  move 

Check 1 

Check 2 

Fetch Begins Fetch Ends 

S6 
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S Code  Error  Action  Message  

S7 Wrap pot 

voltage limit 

hit- Power to 

MP and LSP 

motors cut. 

1. System cuts power to MP motor and 

LSP motor.   

2. Throw Error  

3. Lock Screen 

 

This most likely occurs on while using 

manual switches.   

“S7 Overwind condition 

See Supervisor ” 

 

  

 

 

 
 

Notes: An S7 “Overwind Condition” error is typically caused by one using the manual switches and forcing the 

machine to move in either the counter clockwise or clockwise position to its upper limits.  If this occurs the 

wind indicator lights will turn red on the control panel and power will be cut to the affected motor (MP or LSP).  

If this occurs, the correct procedure is to center the platters manually using the manual switches.  You must 

move the platters until such time the wind indictor lights turn green.  You can then turn the system off and have 

it recalibrate in auto mode and continue.  

  

 

 

Speed 

Time  

                 Move Cycle 

s6 

Manual 

movement 

Manual 

switch on 

Power cut 

S7 
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S Code  Error  Action  Message  

S8 System 

failed to 

accelerate 

to required 

speed at 

check point 

1  

Check wind count and Attempt to 

recalibrate 3 times with no error and 

refetch.  If unsuccessful throw error and 

lock touch screen.     

“S8 Possible Jam on 

Platter X See Supervisor” 

 

  

 

 

 
 

Notes:  

 

An S8 error occurs when the system is unable to reach the required speed by the time it reaches checkpoint 

1 on the acceleration ramp.  This error is usually a soft jam and is caused by an item that is pinched between 

the chain and a sprocket.  This almost always happens on the LSP or serpentine chain.  The administrator 

should remove the side panel and inspect the chain for any obstructions.  Clear any obstructions and restart 

the machine so it recalibrates.  

 

 

 

Speed 

Time  

Accel.  

Ramp 

                 Move Cycle 

Decel.  

Ramp  

sS

s6 

Full speed part  

Of  move 

Check 1 

Check 2 

Fetch Begins Fetch Ends 

S8 
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S Code  Error  Action  Message  

S9 System 

failed to 

accelerate to 

required 

speed at 

check point 

1  

1 Check wind count and Attempt to 

recalibrate 3 times with no error and 

refetch.  If unsuccessful throw error and 

lock touch screen.     

“S9 Possible Jam on 

Platter X See Supervisor” 

 

  

 

 

 
 

Notes: 

 

 An S9 error occurs when the system is unable to reach the required speed by the time it reaches checkpoint 

2 on the acceleration ramp.  This error is usually a soft jam and is caused by an item that is pinched between 

the chain and a sprocket.  This almost always happens on the LSP or serpentine chain.  The administrator 

should remove the side panel and inspect the chain for any obstructions.  Clear any obstructions and restart 

the machine so it recalibrates.  

 

 

 

 

 

 

Speed 

Time  

Accel.  

Ramp 

                 Move Cycle 

Decel.  

Ramp  

sS

s6 

Full speed part  

Of  move 

Check 1 

Check 2 

Fetch Begins Fetch Ends 

S9 
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Door Maintenance  

 

 

 1/10/2005 

Bulletin No: 1002 

Products Affected: RoboCrib 1000 RoboCrib 2000 

Summary: Bin door lubricating procedure  

Description of Issue: Standard maintenance change bin door lubricating procedures. In effort to reduce the number of 

difficulties in closing bin doors as well as reducing the number of bin doors that intermittently do 
not open when actuated.  

Solution: The following procedure is recommended as periodic maintenance of your system.  About every 
three months or more often if your machine is in a dusty / dirty Environment.  PLEASE NOTE: THIS 
PROCEDURE SHOULD BE PREFORMED PRIOR TO CONTACTING TECHNICAL SUPPORT FOR A STICKY 
DOOR PROBLEM 
 
Step 1.  Remove the Door Assembly front panel from the machine 
 
Step 2.  Remove the individual latch covers. This will expose the door actuation mechanism. 
 
Step 3.  Using a can of WD-40 or LPS with the red application tube installed in the spray nozzle – 

lubricate the mechanism in the areas show on the attached drawing. 
 
Step 4.  Check proper alignment of the encoders 
 
Step 5.  Reinstall covers 
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Care and Maintenance 
 

Repairs 
Disconnect defective equipment from power immediately 
(unplug the equipment from the wall outlet).  Any attempt by 
untrained persons to perform repairs may result in 
considerable hazards for the user. 
 
Important Note:  If the equipment is still under warranty, 
contact AutoCrib Technical Support for repair/replacement 
instructions. 
 
If a cable or cable gland is damaged or defective, replace 
the cable as a complete unit with all of its connectors. 
 
Do not open the scale while it is carrying current.  Allow 
approximately 10 seconds to elapse after disconnecting the 
equipment from power before opening the equipment 
housing.  Proper fitting of all surfaces is essential for the 1P 
rating of the housing; for this reason the device must be 
opened and closed by a certified technician. 
 

Safety Inspection 
Safe operation of the scale is no longer ensured when: 

- There is visible damage to the device or power 
cord 

- The built-in power supply no longer functions 
properly 

- The device has been stored for a relatively long 
period under unfavorable conditions (e.g., extreme 
moisture) 

 
If there is any indication that safe operation of the scale is 
no longer warranted: 

- Disconnect the equipment from power 
- Notify AutoCrib Technical Support 

 

Cleaning 
Disconnect the scale from power (unplug from the wall 
outlet) and disconnect any data cables. 
 
Make sure that no liquid penetrates the scale housing. 
 
Do not use any aggressive cleaning agents (solvents or 
similar agents). 
 
Do not was down the equipment with water or dry it with 
compressed air; this is not permitted. 
 
>Clean the scale using a piece of cloth, which has been 
wet with a mild detergent (soap). 
 
>After cleaning, wipe down the display and control unit with 
a soft, dry cloth. 
 

 

Cleaning Stainless Steel Surfaces 
Clean all stainless steel parts regularly.  Use a damp cloth 
or sponge to clean stainless steel parts on the scale.  You 
can use any household cleaning agent that is suitable for 
use on stainless steel.  Clean stainless steel surfaces by 
wiping them down.  Then rinse the equipment thoroughly, 
making sure to remove all residues, and allow the 
equipment to dry.  If desired, you can apply oil to the 
cleaned surfaces as additional protection.  Solvents are 
permitted only for cleaning stainless steel parts. 

 

  
 


